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PREMIER+™ 2 Embroidery  

Getting Started Owner’s Class, Mac Version  

Lesson 1, Part 3: PREMIER+™ 2 Overview of Basic Skills / Functions  

(Adding Skills for Embroidery Intro Features) 

Author: Janie Lantz 
 

PREMIER+™ 2 Embroidery Software has some 
features common to all packages, and some 
exclusive to the level of software you’ve purchased.   
These lessons are stepped by package level, and 
build skills.  All owners should begin with Lesson 1, 
Part 1 and progress through the lessons to the 
level of your personal software package. 
 

Additional Options Introduced in PREMIER+™ 2 Intro or Higher  

 Open PREMIER+™ 2 Configure   from Launchpad or a shortcut you placed in the 1.

Dock. 

 Follow the steps to Reset All apps   in the Utilities tab. 

 Click when complete to close Configure. 

 Open PREMIER+™ 2 Embroidery  from Launchpad or a shortcut you placed in the 2.

Dock. 

 If PREMIER+™ 2 Embroidery is already open, click File / New to open a new 

blank page. 

 Click Hoop  in the Main toolbar.   3.

 Change Brand to Universal. 

 Change Machine Group to Universal.  

 Change Hoop Size to 260mm x 200mm – Universal Large Hoop 3. 

 Select Rotated in Orientation. 

 Click OK.  
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SuperDesigns in Control Panel 

 Select the SuperDesign tab  in the Control Panel. 4.

 Click the Category menu .   5.

 Scroll to the top and select All. 

 Scroll the Gallery View menu. 6.

 Drag the slider to scroll through the SuperDesigns. 

SuperDesigns that are actively colored are available in your 
version of PREMIER+™ 2.  Additional SuperDesigns are become 
available according to the package of software you own. 
 Scroll to Celebrations 1. 

 Select the Birthday Cake SuperDesign. 

 Click Style .   7.

This SuperDesign Set’s Style is available as either Color with 
Fills and Borders, or as Line type design.  Each set has different options in Style, and 
some have only one style. 
 Select Line, and the previews change.   

 Click Select Style  again, and select Color. 

 In Size, highlight the current size and then type 3.5”.   8.

The field will automatically change if your Preference is set to mm in 
Configure. 

 Click Apply  to create a Birthday Cake design. 9.

 The Birthday Cake is selected with green corner handles, indicating 

it can be altered or adjusted in size and the stitches will 

automatically adjust to the appropriate Density. 

SuperDesign elements are ‘working files’, as indicated by green corner handles. 
 Click and drag a green corner handle to make the select box larger or smaller, and 10.

the design will automatically adjust the stitches correctly for the adjustment you 

made. 
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 Click Edit / Undo (or Command  Z) to restore the original SuperDesign element. 11.

 Hold the Shift keyboard key as you click and drag a corner handle, and the design 12.

will adjust proportionally in height and width from the opposing corner. 

 Hold Alt/Option and SHIFT keys down together as you click and drag a corner 13.

handle, and the design will adjust proportionally in all directions from the center. 

 Click Edit / Undo until you restore the original SuperDesign. 14.

 Right click or Control  Click over the selected SuperDesign.   15.

 Click Properties in the pop up menu.   

 You can change the Size by adjusting the 

dimension, or by adjusting Width  and Height 

 Percentage.   

 You can also type in an Angle of Rotation . 

 Click Cancel. 

 Right click over the design again and select Style. 16.

 Select Line to change the SuperDesign after you have already made it! 

 Right click and select Style, and select Color again. 

 Right click over the design and select Fix as Stitches.   17.

 The corner handles become white and the embroidery is no longer a 

SuperDesign with editable properties.   

Leave SuperDesign Elements open so you can adjust them as you design! 
Save or Save As will save SuperDesigns as working elements so you can reopen the 
special .vp4 file later and make more changes. 
Export will finalize the open elements to ready them for stitching. 
 
 Click Edit / Undo to restore the embroidery to an active SuperDesign. 

You can Copy  / Paste or Duplicate an active SuperDesign, and the copy retains the 
SuperDesign properties with green corner handles! 
 
Additional SuperDesign sets become active in each level of software package. 
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Letters 

 Select the Letter tab  in the Control Panel. 1.

 Click to open the Font Gallery Viewer. 2.

 Drag the viewer box corners to adjust larger. 

 Browse by dragging the slider up or down in the 3.

Gallery Viewer. 

 Select Kids 10-50mm in the Children 

category. 

 Click OK. 

 Click inside the Letters 4.

box. 

 Type Happy.  

 Change Size to 25mm (1”).   5.

You can type in mm or “ and PREMIER+™ 2 will 
convert to your default measurement setting. 

 Select the line Shape  and select Circle 6.

Clockwise .   

 Click line Shape again to close the menu. 

Circle Clockwise will snap a half circle of lettering onto a 
selected embroidery design, centering at top center, and 
reading from left to right. 
 Make sure the embroidery design has a select box, so the lettering will know 

where to snap. 

 Leave a check beside ColorSort , so all the letters in this word will 7.

stitch in the same thread color change.   

TIP:  If you want to make ‘rainbow’ words, uncheck ColorSort, and then you can later 
change the thread color for each letter after you generate the word! 
Alignment and Spacing are used for multiple lines of words, so don’t apply to this line 
type. 
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 Click Apply  to generate the letters and ‘snap’ them to fit the select 8.

box surrounding the embroidery. 

The lettering rests on a circular baseline with a green handle, indicating the letters 
are an open element and not finalized, so you can make changes to them and 
maintain the stitch integrity. 

 Click and drag the green handle on the lettering baseline to make the 

diameter of the circle larger or smaller, and to move the start point of the letters 

to different locations around the circular baseline. 

 Hold the keyboard Shift key as you click and drag the green handle around the 

circle to move the start point of the letters, if you want to maintain the current 

size of the baseline circle. 

 Right click in the work area and select Properties. 9.

 In the Letter Properties you can select a different Font, change the text you 

typed, change the Font Size, and adjust other Properties. 

 Click Cancel to leave the lettering unchanged. 

 Select Edit / Next Design to move to the next design, in this case, the Birthday Cake 10.

SuperDesign. 

TIP:  We want to snap another set of letters the same way, only Circle 
Counterclockwise.  To snap them to the Birthday Cake as we did before, we much 
reselect the Birthday Cake. 
Since the Birthday Cake now lies beneath the lettering (the Birthday Cake stitches 
first so is the first layer, and letters are the second layer), it can be tricky to select 
simply by clicking it with a mouse click. 

 Highlight and delete the word Happy in the Letters box. 11.

 Type in Birthday. 

 Change the line Shape to Circle Counterclockwise .  

 Click Apply  to snap the lettering to the selected 

embroidery design. 

 Adjust the lettering as desired.   12.

 Don’t forget to use Edit / Next Design to move between design selections. 
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Design Tab in Control Panel 

 Select the Design tab in the Control Panel. 1.

 Click Select All Visible  in the Select toolbar. 

 Click and drag the embroidery to your right in the work area, leaving one grid 

empty at the right edge. 

 Select File / Insert. 2.

 Browse to \Documents \Premier+2 \Samples \Premier+2Emb \Stitch2 \Toys, and 3.

select the Balloons. 

Remember to use Columns  and Icon  views to toggle 
between column lists and thumbnail views. 
 Click Open. 

 Click and drag them into the left side of the work area. 

 
Resize 

 Click the Resize icon  in the Main toolbar, or select Design / Resize. 4.

 The corner handles on the select box change from white (a fixed or closed 

design) to blue (can be resized and will recalculate the stitches). 

 Hold the Alt/Option and SHIFT keyboard keys, and click and drag the balloons 

larger till they have only one grid of empty space above and below the edge of 

the work area. 

TIP:  If you don’t initially adjust the design to your desired size, use UNDO  to restore 
to the original size, then try again.   
Since Resize recalculates all the stitches, it’s best to restore them to their original 
state before resizing again. 
The Resize function must be turned on for each individual design, or for a selected 
group of multiple designs, in the work area.  

 Click the Resize icon  in the Main toolbar to toggle the function off and restore 5.

white corner handles to the design. 
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 Click and drag the balloons into place along the hoop to 6.

your left, so they leave a grid of empty space on the left, 

top and bottom. 

 Rotate, mirror or adjust as desired, but leave a little 

empty space all the way around the work area of the 

hoop, so we can add a frame to finish it all off. 

 
Frames 

 Click Select All   to form a temporary group. 7.

 Click the Design menu and select Center in Hoop.  8.

 Select the Frame tab  in the Control Panel. 9.

 Select Frame  in Type.  

 Scroll the Galley Viewer. 10.

 Browse to Classical 1. 

 Select Frame 7, a rectangle that echoes the shaping of the 

selected embroidery. 

 Select Margin in Frame Surround. 11.

 Change the Margin to 0, so there will be no space 

between the embroidery select box and the center of the 

satin stitch in the frame. 

 Click Apply. 12.

 The Frame is slightly smaller than the select box because the satin 

stitches are centered over the outer edge of the crop box.  Think of 

how a line of satin stitch centers over a line marked on fabric at your 

sewing machine. 

 The Frame was automatically moved to stitch first in the embroidery 

sequence, so all the other stitches that follow stitch over the top of 

the frame! 

 Click Select None . 13.
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 Click Design / Restrict Groups. 14.

 Select Edit / Next Design or  keys until the Frame element is selected.   15.

The Frame is an active element, indicated by green corner handles. 
 Hold down the Alt/option key and the SHIFT key at the same time, and click and 

drag a green corner handle to make the frame proportionally slightly larger from 

the center out, so the lettering and other designs don’t overlap the frame. 

 Make sure the Frame’s corner handles stay square, indicating the frame is still 

inside the work area for the hoop. 

 

Save As / Export 
 Use Save As to create a working file for your embroidery. 1.

 The special .vp4 working format created with Save or Save As keeps the Letters, 

SuperDesign, and Frame information active, so you can reopen the file and 

continue to make changes. 

 Use Export to finalize and close the design so it’s ready for your embroidery 2.

machine. 

TIP:  You’ll notice the Hoop is automatically rotating orientation during export, so the 
design will be in the correct position in the hoop when you load it for embroidery. 
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Font Utilities and Font Manager  

The Font page and Font Manager have several useful tools for working with system 
fonts in the PREMIER+™ 2 Embroidery Software! 

 Close  the current Program window. 1.

 Select the File menu, and then New to start a new, blank window. 

 Select the Letter tab  in the Control 2.

Panel. 

 Click the Font viewer.  3.

The last used font is visible in the preview 
window. 

 Drag the slider to scroll to view the fonts.   4.

 Categories are indicated by a title bar, 

and fonts appear below each category. 

If the preview is faded out and you can't 
select it, the font is not available in the 
software package you own. 

 Scroll to and click the Abbi 15-25mm Font in 5.

the Display Category.   

 Click OK to select the font, and it becomes the selected font . 

 Open the Font viewer again, if you loaded the Abbi font. 6.

 Click Heart Initials 2C UC 30-50mm MF font in Display Category, a font available 

in Intro or higher versions of PREMIER+™ 2. 

Fonts are coded by their characteristics.   
 2C is two color.   

 UC is upper case letters only.   

 30-50mm is their size range.   

 MF indicates the font is Motif Fill. 

 Click in the Search String field. 7.

 Type Curlew in the field. 
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 The Font viewer selection goes to Curlew 15-50mm font from the Elegant 

Category. 

 Click close  beside the Search field to return to the full 8.

listing of Fonts by Category. 

 Check the Size field , and change the Size to 25mm. 9.

 Only available fonts in the specified size range appear in the list. 

 Adjust the + or - to 4mm, so fonts can be 4mm larger or smaller than the 

specified size. 

 Uncheck Size to restore the entire list of Fonts by Category. 

 Click OK to load the currently selected font. 

 
Importing Embroidery Files as Fonts 

 Click Font Manager . 10.

 Click Import Font from Embroideries . 

 Type Scroll Sample as the Name for the set of 11.

embroideries you are importing into the Font system 

folder. 

 Click OK to open the browser to find the folder containing your embroidered 

letter set. 

 Browse (in Column view ) to \Home \Premier+2 \Samples \Premier+2Emb 

\Stitch2 \Alphabet. 

TIP:  Since Import Font is recreating the letters to be used in the System Fonts for 
alignment, spacing and shaping, you need to tell the Font Importer which letter is 
which.  This is called mapping the letters to the system. 
 The information in the Title Bar at the top of the screen tells you to select the 

Upper Case A for the first letter you are going to map.  

 

 Select Icon view , and click the Upper Case A in the folder. 12.

 Click Open to accept the selection. 
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 The A becomes highlighted in the 13.

character list, and visible in the preview 

window on a red baseline. 

TIP:  The baseline is used later for aligning 
the bottom of letters when you type them 
into the Letter box in the Letter page. 
 This letter is ‘floating’ a bit above the 

baseline.   

 The end of the scrolling line on the 

left side should sit just a little below 

the baseline, and the bottom of the 

satin stitches should be resting on the baseline. 

 Click the arrow down on the Baseline adjust tool  until the baseline 14.

moves to the correct placement under the letter . 

TIP:  You can adjust the Baseline up or down in 
increments of 0.1mm for each letter you insert into 
the Characters list. 

 Click and drag the Zoom slider to the right, until the 15.

A fills the view, to check your work. 

 Click the upper case B in the Characters list.   16.

 Select the upper case B in the folder storing the embroidered letter set.   

 Click Open.   

 Adjust the Baseline as desired. 

 If you accidentally load a letter incorrectly to its corresponding Character, click the 17.

Character. 

 Click Delete.   

 Click Load to open the design folder and reselect the correct letter. 

 To finish loading all the letters and characters in your embroidered letter set, repeat 18.

these steps. 

TIP:  There are too many characters to see in one screen, so drag the slider down to 
see the rest of the Character List. 
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Or Change to a different Character Set if you don’t see a specific 
character in the Extended or Super Extended sets. 
For the lesson today, we won’t finish this set, but once closed, you 
cannot reopen the letters, so we will also learn how to delete a set 
that is partial or no longer used. 

 Click Close. 19.

 Click Yes in the reminder that you can no longer add 

more letters once this session is closed. 

 The new font is located under My Fonts in the Font 

Category List. 

 Select Delete. 20.

 Click Yes to the prompt that you cannot undo the 

Delete. 

 The font is removed, and when you get home from 

class, you can use the lesson steps to add a complete Font from the embroidery 

sample folders to practice the steps. 

TIP:  If you were currently using a font from the MyFonts folder, you may need to 
close down the entire system before you can select and delete fonts from MyFonts. 
To do so, change to one of the installed font Categories in the Letters tab.  Close all 
open PREMIER+™ 2 Embroidery modules. 
Reopen PREMIER+™ 2 Embroidery, select the Letter tab, and Font Manager.  Select 
any font from the My Fonts category, and then Delete, to clean up your My Fonts 
folders. 
Only fonts you have created with QuickFont or MyFonts may be deleted. 

 
QuickFont 

QuickFont   has many options, so we’ll step through the basics, and then you can 
consult the User and Resource Guides to learn the additional features. 

 In the Font Manager  window, select QuickFont . 1.

 QuickFont will open a new program window, and you may need to click the icon 

in the Dock  if it doesn't appear in your view (hidden behind other apps). 
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 The first page in the QF Assistant lets you select from all Open or TrueType fonts 2.

available in your Mac OS, and set their Style as Regular, Bold, Italic or Bold Italic. 

 
 Select Arial and Regular for the font and style. 3.

 The selected font and its style show in the Preview Window. 

 You choose by File Type whether to add the set to your PREMIER+™ 2 4.

Embroidery system Letters tab under My Fonts, or to 

export a set for select brands of embroidery machines. 

 Select For using in the PREMIER+™ 2 Embroidery 

System. 

 You can choose from one of several Character Sets, 5.

depending on the characters used in your selected font.  

Extended and Super Extended are the most commonly 
used Character Sets. 
 Select Extended. 

 Click Continue. 6.

 Choose from a selection of different Stitch Types for your new 7.

Font. 

 Select Satin . 

The Stitch Type preview changes to indicate which Stitch Type you select. 
 Select a Minimum and Maximum recommended Output Size 8.

Range. 

TIP:  Size Range will vary according to the Stitch Type you 
selected.  Pattern Fill letters can be made much larger Maximum than can Satin or 
Outline lettering. 

 Select Baseline, the most commonly used Joining Point. 9.
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 Use Colors  to specify the initial thread color for the new font.   10.

Some options will be greyed out, like Border Thread or Applique 
Color, if you aren’t making an Applique or other style where they are 
used. 

 If desired, double click the Colors icon  and select a different thread. 

 Click Continue to generate the font set. 11.

 When making a system font, Save Font File lists the named file coded by the 12.

characteristics you chose. 

 Arial is the original Windows font name. 

 R stands for Regular type font. 

 S is Satin Stitch. 

 E is Extended. 

 10_50 is the recommend size range you optimized for in this font. 

 The Font Category should be MyFonts.   13.

 Saving all your custom fonts into MyFonts makes finding, using, or deleting them 

easier. 

TIP:  Had you selected to make a font for your embroidery machine, your save 
options would appear like this: 

 

 Scroll through the font preview pages with Previous and Next  14.

under the Preview box. 

 Print Catalog  prints a charted template (when you are connected to a printer, or 15.

you can print as PDF) showing the characters in the font, and other font information. 

 Check New Font / Return to start when I click Done and then click Done when you 16.

want to make another system font or another style of the same Windows font. 

 Or, simply click Done when you are done using QuickFonts. 17.


